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Using a Keyboard in Fusion FX
Introduction
Whether you are using a conventional keyboard or a laptop, there are certain keys that have specific
functions in Fusion FX. It is worth taking the time to familiarise yourself with these keys before you
start any of the Fusion FX training modules. They will save you time and make planning in Fusion FX
easier.
Desktop Keyboard
Enter Key
Used to execute the Okay command on any open menu/window.
E.g. adding selected items to a design.
Shift Key
Used in conjunction with other keys
as shortcuts or with the mouse for
additional functions.

Delete Key
Used to remove items from a
design.

Arrow Keys
Keys
Used to move items within a design.
Tab Key
Used to move quickly between
fields for data input. E.g.
measurements of an item.
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Control Key
Used in conjunction with
other keys as shortcuts or
with the mouse for
additional functions.
© 20-20 Technologies Ltd 2014

Laptop Keyboard

Enter Key
Used to execute the Okay command on any open menu/window.
E.g. adding selected items to a design.

Shift Key

Delete Key

Used in conjunction with other keys
as shortcuts or with the mouse for
additional functions.

Used to remove items from a
design.

Tab Key

Arrow Keys

Used to move quickly between
fields for data input. E.g.
measurements of an item.

Used to move items within a design.

Control Key
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Used in conjunction with other keys
as shortcuts or with the mouse for
additional functions.
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Using a Mouse in Fusion FX
Introduction

An overview of mouse functions within FX are covered below.

Mouse Controls
Scroll Button
Right Button

Left Button

All three buttons can be pushed down and this is known as ‘clicking’.
Therefore you can Left Click, Right Click or Middle Click (using the Scroll Button).
Clicking on these buttons will perform different functions on the screen.

Moving the Mouse

As you move the mouse around on your desk or mouse mat , the mouse pointer
will move on
the screen. Pointing it to objects and menu items will allow you to perform a variety of functions.

In Fusion FX , left click is used to select an item or menu, or to execute a command.
Right Click will make more options appear on screen.

6
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The Scroll Button
The Scroll Button can be rolled as a wheel allowing you to quickly move up and down menus and
lists.
This is particularly useful in Fusion FX when accessing the following:
Catalogue Items
Item List view
Report view
Style information

The Scroll Button can also be used as a middle button.
When clicked, it will move the Fusion Cursor

to the same position as the mouse pointer.
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Starting Fusion FX

If you are using Windows 7, double click the Fusion FX icon
Fusion FX from the Start button/All Programs option in your taskbar.

on your desktop, or select

If you are using Windows 8 in touch-screen mode, type Fusion FX anywhere on your desktop then
click on the Fusion FX icon.

Enter you login name and
password.
The default Login name and
Password is ‘admin’ in
lowercase.

The Lookup customer screen will appear.

8
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You can select an existing customer and click Okay or you can create a new customer by clicking on
the New button

9
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Creating and Editing Customers
Introduction
Customer details are all stored within a database in Fusion FX. Fields for inputting customer details
can be tailored and made mandatory.
Creating Customers
Select Customer and click on the New button.

Enter the relevant customer information then click Create.

Address fields in Bold text
are compulsory

10
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Editing Customers

Select Customer and click on the Edit button.

Amend the customer details as required and click OK.
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Creating a New Design
Introduction
Designs can be created, edited, copied and exported. There is no limit to the number of designs
created for each customer.
To create a new design, click on the New button in the bottom half of the screen.

In the New Design Details window, enter a design name and a Budget.
Click Okay

12
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Select the catalogue group for this design and click Okay.
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Simple Wall Templates
Introduction
Simple wall templates can be used to create basic wall layouts. This is the quickest and easiest
method of setting up a room. All you need to do is enter the correct dimensions.
Once you have selected the Catalogue Group, the Wall Layout Wizard will appear
Select the layout required

Use the rotation tools to orientate
the room layout

Enter the Dimensions

Click Okay

14

© 20-20 Technologies Ltd 2014

Multiple Wall Tool
Introduction
For wall layouts that vary from the basic shapes in the Wall Layout Wizard the Multiple Walls tool
should be used. If used correctly, this tool can create most room shapes.

In the Wall Layout Wizard, click on Multiple Walls
Now start the wall layout by clicking one of the directional arrows

Enter the wall dimensions in this dialogue box and click on Add Wall

15
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Continue to add each wall by selecting a directional arrow and applying dimensions in the same way

Gaps can be created by clicking on
the gap button

Use the undo button if you make a
mistake. You can Undo and Redo
back to any stage of the layout

Adding an angled wall
Select one of the angled directional arrows

The dialogue box will give you more
options
You can either enter the length and
angle (if they are known) or you can
enter measurements a. and b.
(Fusion FX will calculate the length
and angle for you)

Entering measurements a. and b.
will form two sides of a triangle
allowing Fusion FX to calculate the
third (the angled wall).

16
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Use the Complete button to join the start and finish points together

If there is only one angled wall in the design, you can use the Complete button to work out the angle
for you. Make sure that you start the layout so that you can finish with the angled wall.
Wall layouts must always be drawn in a clockwise direction.
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Tabs and Ribbons
Introduction
The purpose of this module is to familiarise you with the layout of Fusion FX and explain how to
access the main functions.
The program is divided into a number of Tabs. Each Tab allows you to access a ribbon which runs
along the top of the main screen.
TABS

Each ribbon is divided into groups of buttons which perform individual functions. This is the same
format used in the Microsoft Office Suite.
The exception to this is the FILE Tab.

The FILE Tab will allow you to create new customers and new designs. You can also manage
catalogues, import and export designs from this screen.
To access the other ribbons from
this screen, click on the arrow

18
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The HOME tab will give you access to a whole range of tools and functions.
These include style details, pricing and the measure tool.

The INSERT tab is used to place items in a design. This includes catalogue items, auto-features
(worktop, plinth etc), coverings (tiles and colours etc) and non standard items.

The cursor

controls can also be found in this ribbon

The ANNOTATE tab is used to place, reposition and change dimensions and text on a plan or
elevation view.

The VIEW tab will allow you to access and use the controls for any view.

Everything related to Viewing can be found in this ribbon including navigation, lighting, zoom and
movie creation.
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The ITEMS tab only appears when one or more items are selected in the design.

Everything related to moving or modifying an individual item or a group of items can be accessed
here.

There is a special section for walls in
this ribbon. It will allow you to
modify room layouts and change the
appearance of walls in plan view.

20
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Floating Palettes
Introduction
There are two floating palettes in Fusion FX which will give you flexibility with your screen layout.
Both the Catalogue Items palette and the Navigate View palette can be repositioned, resized,
minimised or switched off when not in use.
Moving the palette can be
achieved by dragging the title bar
to any position on the screen.
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As you move the palette, docking points appear on screen which will allow you to ‘dock’ the palette
at the top, bottom, left or right side of the screen. This fixes it into position.

To dock the palette,
drag the title bar until
the mouse pointer is on
the docking point

Once docked, the palette can be minimised and locked by clicking on the pin.

The palette can be hidden
completely by clicking on the close
button

Floating palettes can also be resized
by dragging the edges, top or
bottom with the mouse.

The palette will remain locked until you click on the pin again.

22
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Doors and Windows
Introduction
Doors and windows are usually added to a design directly after creating a wall layout. This is done by
simply dragging and dropping the items into walls.
Select the INSERT tab, select Catalogue Items.

Select either the Door or Window option

You can now find the item you require using any of the methods shown below:

Type the Item Name here (e.g. ID10).
Type part of the description here
Use Add criteria from this list

Using primary and secondary filters is a quick way of looking at available doors or windows of a
certain type.
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Clicking on the Reset button will remove any previous search criteria and allow you to start a fresh
search.

You can remove any add criteria
buttons by selecting remove.

Now that you have a door or a window selected, drag it into the appropriate wall.

A dialogue box will appear. This will allow you to make changes to the default measurements of the
item. Distance Left or Right is the distance to the nearest wall as you look at the item from within
the design. Select OK when you have completed the changes.
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Adjusting doors and windows
Doors and Windows can be adjusted once placed although it is usually just as quick to delete the
item and add it again.
Select the door or window and click the Editing Tools Tab in the ITEMS tab.

The length and height of the
selected door can now be
amended accordingly.
Move the selected object along
the wall using the mover arrows.
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Saving and Closing Designs
Introduction
Fusion FX automatically saves the open design at regular intervals (the default setting is every 5
minutes). You can also manually save a design at any time.
To save a design
Click on the FILE tab

Click on Save

To close a design
Either click on Close in the FILE tab or use the close button in the top right-hand corner of the main
screen
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Adding, Moving and Deleting Items

Introduction
The cursor is used within a design to place items with greater accuracy than dragging and dropping.
Select an item by clicking on it in the Catalogue Items palette.
You can add an item by using any of the methods outlined below:

Double click on the item’s image

Click on the Add button

Use the Return/Enter key on your
keyboard

You can also replace an item that is already in the design by selecting it, selecting a new item in the
Add Palette and using Replace.

Adding an item using drag and drop
Hold the left mouse button down on the item’s image in the Add Palette and drag it to the design.
Moving it towards a wall will orientate it so that it faces the centre of the room.
Release the mouse button when it is correctly placed.
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To move an item
You can drag an item using the mouse. Hold the left mouse button down on the item and drag it to
another position.
You can also use the Move controls in the Items Tab.

Select the required direction then enter the distance in the space provided.

To rotate an item in plan view
Right click on the item, select Free Rotation, select the item name. Move your mouse pointer
around the item to rotate it. Using the Control key as you do this will snap the item to 45 degree
angles.

Right Click

To delete an item
Select the item and use the Delete key on your keyboard.
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Clashes
Introduction
Fusion FX employs an automated clashing system which will allow you to identify, correct, ignore or
review any potential issues within the design.
Clash Warnings
As soon as a clash occurs, a warning appears above the drawing area. In the example below, two
wall units are overlapping.

The warning in the orange bar will identify the items involved.
The warning bar will stay visible until you either deal with the clash or close the clash warning by
clicking on the cross at the end of the bar.
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In the example below, there are two clashes but the warning bar has been closed.
You can review all clashes at anytime by selecting the HOME tab and Clashes

Selecting a clash will highlight the
relevant items on the plan.

All clashes can be selected or
deselected using these buttons.
You can acknowledge or unacknowledge a
clash. You can also hide acknowledged
clashes.
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In the example below, the tall housing is clashing with the window.

The clash has been acknowledged and acknowledged clashes are switched off therefore the clash is
no longer visible.

Acknowledged clashes can be switched back on at anytime.
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Cursor Control
Introduction
The Cursor

can be used to accurately place units and appliances in a design.
When a unit is added using the
cursor, the side of the unit will be
placed against the short arm and the
back of the unit will be placed
against the long arm

The following commands will allow you to move the cursor to the correct position.
Position Cursor
Point to a location on the plan and push the scroll button down. Alternatively, you can right click and
select position cursor.
Attach Cursor to
Right click on an object e.g. a unit or a wall then point Attach cursor to, then left click on the item
that you want to attach it to.

Right click on an item
Point to Attach cursor to
Left click on the item name

Rotate Cursor
To rotate the cursor, hold down the Control key and press 9 on your keyboard.
Each time you press 9, the cursor will rotate by 90 degrees.
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Planning Direction
By default, the cursor operates in a clockwise direction. This can be changed by selecting the INSERT
tab and clicking on the Planning Direction button.

There are other controls in this group of buttons that will allow you to move the cursor and rotate it
in different ways.
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Measure Tool
Introduction
The Measure tool can be used to measure the distance between two points. It can also be used add
items to a design with the correct measurement without making any amendments to the item
before adding it.
Measuring a distance
In this example we will add filler to a gap that we have measured.
Select the Home tab, select Measure.
Click on the point to measure from and the point to measure to.

Click here

By default, the measure tool snaps to 45 degree angles. Using the Control key will override the
snapping.
The measurement is recorded at the bottom of the screen. Now press the Enter key.

If *basefiller has been selected in the Catalogue Items Palette, it will be applied to the gap that has
been measured.
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Zoom Tool
Introduction
When working on a small area of the plan, you can zoom in to get a better view of the area you are
working on.
The Zoom tool can be found by selecting the VIEW tab.
Zoom In
To zoom in once on the current cursor position, click on Zoom, select Zoom In.

Zoom Out
To zoom out once from the current cursor position, click on Zoom, select Zoom Out.

To Zoom in or out multiple times, double click on Zoom, then left click to zoom in or right click to
zoom out.

Click on the Zoom tool again to deselect it.
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Undo and Redo
Introduction
Undoing actions and Redoing actions in Fusion FX are unlimited. Any time you make a mistake or
want to step back a few actions you can use the process below.
Undo the last command issued using the ‘Undo’ button in the Quick Access Toolbar
The shortcut keys for this action are CONTROL and Z

Redo the last command issued using the ‘Redo’ button in the Quick Access Toolbar
The shortcut keys for this action are CONTROL and Y

You can revert back to a specific point by using the drop down menu to the right of the undo or
redo button.
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Control and Shift Keys
Introduction
These keys are used in conjunction with the mouse for specific functions within Fusion FX.

The following functions can be performed using either of these keys.

Multiple selection in dropdown menus
Using Control or Shift while selecting/deselecting from a drop down menu will keep the menu open.
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Item selection in graphical views
Using Control or Shift while selecting/deselecting items in Plan, Elevation or Perspective view will
add those items to items already selected.
Deselecting items in Plan, Elevation or Perspective view while using Control or Shift will maintain the
current selection status of all other items.
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Selection Methods
Introduction
There are several ways of selecting items in a design. An item could be a wall, an appliance, a unit, a
door or a graphic. You will need to select an item before you can change, move or delete it.
This module demonstrates how to use the three basic selection methods. These will cater for most
situations.
Left Click
Simply click on the item you want to select.

Holding the Shift key down as you
click will allow you to select multiple
items

Drag or Lasso
Hold down the left mouse button and drag around an item or group of items. The shape formed by
dragging must completely surround the item(s) that you want to select.

Holding the Shift key down as you
drag will allow you to select multiple
items
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Right Click
When you have more than one item in the same location, using any of the other two methods could
result in selecting the wrong item(s).
By using Right Click, then pointing to Select, you can choose from all the items listed.

Right Click on the object
Point to Select

Left Click on the
item name
Deselecting
If you have selected a group of items, you can deselect an individual item by holding down the Shift
key and clicking on it or dragging around it.
To deselect everything, click on an empty space either inside or outside of the room.
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Autofeatures
Introduction
Auto-features will allow you to automatically add linear items to a design, such as worktop, plinth
cornice and light pelmet. This saves time finding these items and is easier than manually drawing
them.
To add auto-features to a design, select Insert, select Auto Features

The Auto-features menu will allow you to select those items to be added to your design.

If Edit Worktops is selected, you will be
given the opportunity to edit the worktops
that have been added to the design.

Click OK to close the Auto-features menu.
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The Style Details menu will appear, allowing you to change the type of worktop and colour.

Once you have selected the desired colour click OK to close the menu.
The worktop editing menus will appear.

The first worktop menu will allow you
to resize and reshape the worktops.

Click Next Stage to exit this menu.
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The second worktop menu will allow
you to apply joins to the worktops.

Click on Auto-Joint and then Next Stage to exit this menu.

The third worktop menu will allow
you to link items to each length of
worktop. Your catalogue must be set
up to enable use of this menu.

Click Finish to exit this menu.
This will take you back to plan view.

43
© 20-20 Technologies Ltd 2014

Elevation View
Introduction
Elevation view allows a profile view of each wall within a design. Items can also be added within this
view. Elevation view is often used to display installation items dimensions.
To change to an Elevation View, select the View tab, select Elevation.

Using the four highlighted arrows in
the Position section will allow you
to see a North, East, South or West
profile.

If you want to move items by dragging or you want to add items by dragging them on to a wall, the
wall has to be made active.
Click on the centre icon in the Position section. Click on the chosen wall in the Navigate View
window.

Once a wall is made active, it will be
highlighted in green.

While dragging an item on to an active wall or moving it around, you will notice that it is locked at
the default height for that type of item. To override this, hold the Control key down once you have
started dragging.
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Perspective View
Introduction
Because perspective view is usually the view that is used to demonstrate a design to a customer,
there are many controls which will allow you to change the view and show the design in 3D with a
variety of image renders.
The purpose of this module is to introduce some of the basic controls used to manipulate
perspective view.

Position Arrows
Select the View tab. Select Perspective. Click on one of the Position arrows

Clicking on these arrows changes the view by small increments. You can see the difference in the
two images below.

Default View

One click on the arrow pointing
to the right

45
© 20-20 Technologies Ltd 2014

Default View
To return to the default view at any time, click on the Perspective View dropdown and select
Default.

Navigate View Palette
To access more controls for perspective view, click on the button in the centre of the position
arrows.

The Navigate View palette will appear.

The Navigate View palette is a floating palette and can be repositioned and resized in exactly the
same way as the Catalogue Items palette.
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Navigate View
Introduction
This floating palette will help you get the perspective view angle required. The palette can be
resized, repositioned and hidden when not in use. For more information on the palette controls,
refer to the Floating Palettes section of this booklet.

From/To
With this mode selected, the view is controlled by clicking on the mini plan.

Left click on your focal point.

Right click on your point you are
viewing from
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Left/Right
With this mode selected, the view is controlled by using the left and right mouse buttons.

Use the left and right mouse
buttons to determine the angle of
view

View Heights

The scroll bar on the left is
used to change the View
From height.

48

The scroll bar on the right is
used to change the View To
height.

© 20-20 Technologies Ltd 2014

Hide Walls
When selected, the Hide Walls function will automatically hide any wall obstructing the view into
the room. This will allow you to achieve much wider views by ‘standing back’ outside the room.

If this feature is switched off, walls will appear as normal.
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Wide Angles
Getting a wider view can also be achieved by using the Shift key and clicking outside the arc of view.

Hold down Shift and click outside
the arc of view.

Clipping Plane
A horizontal scroll bar can be used to ‘clip away’ obstacles to the current view.

All items behind the clipping plane
become invisible.
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Render Settings
Introduction
There are many render settings to choose from in Fusion FX. By default, the initial render for a
perspective view is Wireframe. There are 5 standard renders and 3 High Quality renders which vary
in quality and speed.
Generally, the higher the quality, the slower the speed. This is because Fusion FX is calculating light
displacement and shadows etc in the High Quality renders.
To change the current render
Select the View tab and Setting in the Render section.

Planning Mode
This will allow you to change your view quickly regardless of the chosen render because it renders
instantly. During the early stages of a design, having Planning Mode switched on will speed up the
design process.
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Examples
On the following pages you will see an example of every available render.

Wireframe

White Fill

Colour Fill

Draft
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Preview

HQ Preview

HQ Present

HQ Publish
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Artistic Renders
These special effects such as Freehand or Monochrome provide an alternative appearance to the
standard Renders.
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Dimensions
Introduction
Dimensions can be automatically added and updated during the design process. This feature can be
switched on using the methods described below.
To add automatic dimensions to a plan, select the Annotate tab and select Item Settings to select
the items that you wish to dimension.

Finally, select Items to apply the selected dimensions.

Auto-dimension as you plan
By selecting Auto-Items, dimensions will automatically be applied to units as
they are added.
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Annotations
Introduction
Annotations can be added and automatically updated during the design process. There are a number
of ways in which the plan can be annotated.
To add automatic annotations to a plan, select the Annotate tab. Now select the type of annotation
that you require by clicking on Annotate By.

Finally, select Items to apply the selected annotations.

Numeric Annotations
If you select Numeric Annotations, you can choose how the numbers are applied from the dropdown list. The standard method is Type/Position which will number all the base and floor standing
units in a clockwise direction, then do the same with the wall units.
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Set Start
When using numeric annotations the start point (number 1) can be set by positioning the cursor
before the first item (in a clockwise direction). Then select Annotate By, Numeric and Set Start.

Auto-annotate as you plan

By selecting the Auto button,
annotations will automatically be
applied to items as they are added.
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Dressing
Introduction
Dressing will add decorative items to your design such as plates, pots, pan and utensils.
There are two ways this can be achieved - using Auto Dressing or manually placing each item from
the Advanced Graphics catalogue.
Auto Dressing
Select the Insert tab, select Auto Dressing.

Dressing items will automatically placed in your design based on the position of your units and
worktops.

Manually add dressing items
If Auto Dressing does not place items where you want them or you want alternative items, you can
manually add them to the design from the Advanced Graphics catalogue using drag and drop or the
cursor.

Use the Primary Type filter to find
the correct type of item.
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Styles and Colours
Introduction
Styles can be changed for the whole design or for selected items. In addition, any individual surface
within the design can be altered to any colour, pattern or image.

Default Style
To change the default style for all items of a particular catalogue, select the Home tab and select
Default Style.

Select the catalogue for the styles
you want to change. Click OK.

s

Select a category on the left and the
style options will appear on the
right. Click Ok when you have
finished making changes.
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Selection Style
To change the style of an individual item or a group of items, select the items concerned, select the
Items tab and Selected Style.

The Style Details menu will appear.

Only those styles that are relevant
to the selected items will appear.
Click OK when you have finished
making the required changes.

evert back to Default Style
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Change back to default

To revert back, select the units, Click
the Selected Style option drop-down
arrow, Assign to Existing, Default Style.
The selected units will now revert back
to default style.

Change material
To change the appearance of an item, right click on it and select Change Material then select the
item name
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When the Change Material menu appears, select the colour that you want to change and select
Replace

On the Select Material Menu, use the filters at the top to select the material type, catalogue,
surface type and colour.

Click OK when you have made your selection.
Click OK again to close the Change Material Menu
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The Item List
Introduction
All items added into a design are visible within the Item List view. The best way to manipulate and
select very small items is to use this Item List view. The Item List can also be used to check prices,
descriptions and sizes.
Any item can be added to the design via the Item List, but items added this way will not be visible in
a graphic view.
To access the Item List, select the View tab and Item List.

The drop down menu in the Item List gives other available display options.
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Item type display allows you to turn on or off Graphic items, fixtures etc. in the item list view.

List Items By display allows you to sort the item list by any of the categories listed.

Group By Links will display the linked items together.

Field Chooser allows you to add or remove item list fields.
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To insert a field in the item list, drag
a field from the Field Chooser into
the column heading.

Fields can be added in any order. Existing fields can also be repositioned by dragging them along the
column heading.
Small arrows indicate where the field can be dropped.
To remove an Item list field, drag the field from the item list into the Field Chooser.
VAT can be switched on or off depending on how you want prices displayed.
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Reports
Introduction
There are many standard reports available in Fusion FX. Quotes, invoices delivery notes and even
profit and loss reports are available.
In addition there is a facility to create bespoke reports using the Report Wizard.

Standard Reports
To access a report, select the VIEW tab and click on the report drop down arrow. This will display all
the available reports.

List of Reports
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Select the report you want by clicking on it.
When the report appears, you can adjust the scale to make it more visible.

If you select a report which has RTF in its name, this will produce a word document and you will be
prompted to save it to a location of your choosing. It can then be altered like any other word
document.
Detailed information on changing prices, discounts, factors, Report Wizard and Non Standard Items
can be found in the Pricing with Fusion FX booklet.
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Printing
Introduction
Fusion FX can at anytime, print the current view. It can also print named views that you saved
earlier. It is also possible to print directly to a pdf document which can be saved to a location of your
choice, either on your computer or your network.

Select a view in the VIEW tab.

Select the FILE tab then select Print
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Print Options
There are lots of print options available and these are described below.

Select the printer you wish to use
here.

You can print all pages or select
certain pages here.

The page orientation can be switched between
landscape and portrait.
Select the paper size here.
The type of print allows other
options such as worktop layouts.
Any render can be selected here before printing.

The preview render can be the
same as the print render or wire
frame (to speed up the time it takes
the preview image to render).
Print Preview
Below the print preview image, there is a set of arrows to navigate between pages. There is also a
slider to adjust the size of the preview window.
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Printer Properties
Selecting Printer Properties will display any other options available for the printer you have chosen.

These additional options vary between printers. An example is shown below.

Send to PDF
When selecting the printer, Send to PDF will allow you to print the image to a PDF document in a file
location of your choosing.
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Print
Once you have checked the print options, click on the Print button to print.
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